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Warranty and liability 
Note The application examples are not binding and do not claim to be complete 

regarding the circuits shown, equipping and any eventuality. The application 
examples do not represent customer-specific solutions. They are only intended 
to provide support for typical applications. You are responsible for ensuring that 
the described products are correctly used. These application examples do not 
relieve you of the responsibility of safely and professionally using, installing, 
operating and servicing equipment. When using these application examples, you 
recognize that Siemens cannot be made liable for any damage/claims beyond 
the liability clause described. We reserve the right to make changes to these 
application examples at any time without prior notice. If there are any deviations 
between the recommendations provided in these application examples and other 
Siemens publications – e.g. Catalogs – then the contents of the other documents 
have priority. 

 

We do not accept any liability for the information contained in this document. 

Any claims against us – based on whatever legal reason – resulting from the use of 
the examples, information, programs, engineering and performance data etc. 
described in this application example shall be excluded. Such an exclusion shall 
not apply in the case of mandatory liability, e.g. under the German Product Liability 
Act (“Produkthaftungsgesetz”), in case of intent, gross negligence, or injury of life, 
body or health, guarantee for the quality of a product, fraudulent concealment of a 
deficiency or breach of a condition which goes to the root of the contract 
(“wesentliche Vertragspflichten”). However, claims arising from a breach of a 
condition which goes to the root of the contract shall be limited to the foreseeable 
damage which is intrinsic to the contract, unless caused by intent or gross 
negligence or based on mandatory liability for injury of life, body or health. The 
above provisions do not imply a change in the burden of proof to your detriment. 

It is not permissible to transfer or copy these application examples or excerpts of 
them without first having prior authorization from Siemens Industry Sector in 
writing. 

 

For questions about this document please use the following e-mail address: 

online-support.automation@siemens.com 

 

 

 

mailto:online-support.automation@siemens.com�
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Application Description 1
 

1.1 Overview of the automation task 

The objective of this application is to describe the configuration and diagnostic 
capabilities of a PROFINET IO system. In addition, this document describes the 
integration of a PROFIBUS line and a wireless subsystem into a PROFINET IO 
system. 

1.2 Overview of the automation solution  

Diagrammatic representation 

The following figure schematically shows the most important components of the 
solution: 

 

Figure 1-1 
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PN IO
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Configuration 

In this case, the PROFINET IO controller is a CPU 319-3PN/DP. As PROFINET IO 
devices, the following components are connected to the PN IO system using 
Ethernet cables: 

 ET 200S with IM 151-3 PN 

 ET 200ecoPN 

 IE/PB Link PN IO 

 W788-1RR 
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These components are connected to the SCALANCE X208 Ethernet switch in a 
star configuration. 

Since the IE/PB Link is used as a gateway between PROFINET IO and 
PROFIBUS, PROFIBUS DP slaves can also be connected via this module. This 
module is an ET 200S with IM 151-1 Standard. 

An ET 200pro IWLAN is additionally connected to the W788-1 RR wireless access 
point as a PN IO device. 

A PG/PC with Ethernet interface is used as a configuration and programming unit. 

Main contents 

The following topics are discussed in this application: 

1. Configuration of the PROFINET IO system as shown in figure 1-1 

2. Fast Start-Up function 

3. STEP 7 diagnostic functions (incl. Topology Editor)  

4. Web server diagnostic functions 

Advantages of this solution 

The configuration presented here shows you the advantages currently offered by 
PROFINET: 

 Easy and inexpensive connection of a PROFIBUS line to PROFINET IO 

 Increased plant availability due to improved diagnostics 

 Integration of a wireless subsystem 

 Reliable, flexible, expandable, modular solution that is easy to maintain 
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1.3 Hardware and software components used 

The application was created using the following components: 

Hardware components 

Table 1-1 

Component No. MLFB/order number  Note 

S7-300 mounting rail 1 6ES7 390-1AE800AA0  

PS307 5A 
power supply 

2 6ES7 307-1EA00-0AA0 
  

 

CPU 319-3PN/DP 1 6ES7 318-3EL00-0AB0  V2.8 and higher 

64 kB Micro Memory 
Card (or larger) 

1 6ES7 953-8LF20-0AA0 
 

 

ET 200eco PN 1 6ES7 142-6BF00-0AB0 8 D0, V6.0 and higher 

SCALANCE X208 1 6GK5 208-0BA10-2AA3  

IE/PB Link PN IO 1 6GK1 411-5AB00  

SCALANCE W  
788-1 RR 

1 6GK5 788-1AA60-6AA0  

ET 200S: 

IM 151-3PN  
interface module 

1 6ES7 151-3AA23-0AB0 V6.0 and higher 

PM-E 24 V DC  
power module 

1 6ES7 138-4CA01-0AA0  

Digital input module 
for ET200S 4 DI  
24 V DC 

1 6ES7 131-4BD01-0AA0 
 

 

Digital output module 
for ET200S/ 4 DO  
24 V DC/0.5 A 

1 6ES7 132-4BD02-0AA0  

Terminal module for 
power modules 

1 6ES7 193-4CD30-0AA0  

Terminal module for 
electronic modules 

2 6ES7 193-4CB20-0AA0  

ET 200pro IWLAN: 

Module carrier, narrow 
for ET 200PRO, 
LENGTH: 500 MM 

 6ES7 194-4GA00-0AA0  

IM 154-6 PN HF 
IWLAN 
interface module 

1 6ES7 154-6AB00-0AB0  

EM 142, 8 DO 24V 
electronic module 

1 6ES7 142-4BF00-0AA0  

Connection module  
for digital electronic 
modules 

1 6ES7 194-4CB00-0AA0  
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Component No. MLFB/order number  Note 

ET200S PROFIBUS: 

IM 151-1 Standard 
interface module 

1 6ES7 151-1AA04-0AA0  

PM-E 24 V DC  
power module 

1 6ES7 138-4CA01-0AA0  

Digital input module 
for ET200S 2 DO  
24 V DC/0.5 A 

1 6ES7 132-4BB00-0AA0  

Terminal modules for 
power modules 

1 6ES7 193-4CD20-0AA0  

Terminal modules for 
electronic modules 

1 6ES7 193-4CA30-0AA0  

Cables: 

IE FC M12 Plug PRO 1 6GK1 901-0DB20-6AA0  

IE FC RJ45 PLUG 9 6GK1 901-1BB10-2AA0  

IE FC TP STANDARD 
CABLE 

 6XV1 840-2AH10 Sold by the meter 

IE FC stripping tool  1 6GK1 901-1GA00  

    

PROFIBUS connecting 
cable terminated 1.5 m 

1 6XV1830-1CH15  

Power Plug Pro 1 6GK1 907-0AB10-6AA0  

IE Power M12 Cable 
Connector pro 

1 6GK1907-0DC10-6AA3  

Standard software components 

Table 1-2 

Component No. MLFB/order number  Note 

STEP 7 V5.4 SP5  1 6ES7 810-4CC08-0YA5 Or higher version 
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PROFINET Basics 2
2.1 General overview 

Like the PROFIBUS field bus, PROFINET technology is standardized and 
developed by the PROFIBUS user organization.  

PROFINET differentiates between two applications: 

 PROFINET CBA (Component Based Automation) 
this version – which was developed first – defines the cross-vendor 
communication of intelligent automation components and plant parts at the 
control level. Instead of programming the communication between controllers, 
it is configured using the SIMATIC iMAP interconnection editor. 

 PROFINET IO 
defines the connection of distributed field devices to central controllers via 
Ethernet and the cyclic transmission of I/O data. 

One of the main challenges for the development of PROFINET was to use Ethernet 
and other proven IT technologies in all fields of automation. 

Since its introduction, the PROFINET standard has managed to advance to the 
field bus level based on Ethernet, also enabling the transparent integration of 
existing field bus systems – for example, PROFIBUS. The essential advantages 
include: 

 Integrated communication is achieved and interfaces are reduced 

 Engineering is simplified 

 Diagnostics are simplified 

 Use of the existing know-how and protection of investments that have already 
been made 

Due to these advantages, the IT world and the automation world grow closer 
together. 

2.2 PROFINET real-time communication 

Communication is scalable and three performance levels with different response 
times are available: 

  

 TCP/IP (100 ms): For open TCP communication (e.g., for the transmission of 
non-time-critical data: Parameterization, diagnostics)  

 RT (10 ms): Real-time communication for time-critical data (for example, in 
factory automation: Cyclic data, event-controlled messages, alarms)  

 IRT (1 ms): Isochronous real-time for sophisticated applications (e.g., in 
motion control) 
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Figure 2-2 

 

2.3 Functional model 

The functional model for PROFINET IO resembles the PROFIBUS DP model, but 
the master-slave method was converted into a provider-consumer model since all 
nodes have equal rights when using Ethernet. The devices of PROFINET IO are 
referred to as IO controller and IO device or IO supervisor. 

 

Table 2-3 

Device type Description 

IO controller Master for the input/output data of the field devices. Represents the 
communications interface of a controller. 
Corresponds to DP Master Class 1. 

IO device Distributed field device. 

IO supervisor Name for an engineering and diagnostic station. Corresponds to DP  
Master Class 2. 
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Figure 2-3 
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Existing field bus systems can be easily integrated into PROFINET. This is realized 
using a proxy; this proxy is either integrated in a PROFINET device or it is an 
independent device (e.g., SIMATIC NET IE PB Link PN IO). 

2.4 Configuration  

Plant engineering requires the device-specific system data (GSD-XML files) of the 
used field devices (analogously to PROFIBUS DP). It is imported to the 
configuration tool (e.g., STEP7), which, based on the network data, creates an 
address list for the IO controller. The planner assigns a unique logical name to 
each field device. The actual name assignment in the device is performed by the 
DCP (Discovery and Control Protocol) integrated in each IO device. 
To ensure that each device is detected as a node on the Ethernet, an IP address 
has to be assigned to each device. The IP addresses are generated by the 
configuration tool and downloaded to the IO controller as the configuration. 
During system startup, the controller assigns these configured IP addresses to the 
configured field devices.  

This is demonstrated by the schematic diagram below. 
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Figure 2-4 

 

2.5 Diagnostics 

PROFINET offers a powerful integrated diagnostic concept that comprises all 
devices configured in PROFINET (including the network components that are 
PROFINET devices, for example SCALANCE X208). 

Device diagnostics are divided into three levels: 

 Error on the device: Failure of a station 

 Error on the slot: Defect of an individual module 

 Channel error: For example, wire break 

If an error occurs, the relevant IO device generates a diagnostic interrupt that is 
reported to the controller. The user is responsible for its evaluation. 
This diagnostic information can be read out and evaluated by a programming unit 
in the following diagnostics views: 

 STEP 7 Basis diagnostics 

 Diagnostics with the Topology Editor 

 Diagnostics using the Web server of the PROFINET IO controller  
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Installation 3
3.1 Installing the hardware 

For the hardware components, please refer to chapter 1.3. For the hardware 
configuration, please follow the instructions listed in the following table: 

 !  
Attention 

Do not switch on the power supply until after the last step. 

 

 

Table 3-4 

No. Focus Action 

1.  CPU 319-3 PN/DP Insert the MMC into the MMC slot of the CPU 319-3 PN/DP.  

2.  S7-300 mounting rail Mount the following devices on the S7-300 mounting rail: 

 PS 

 CPU 319-3 PN/DP 

 IE/PB Link PN IO 

 SCALANCE W 788-1RR 

3.  ET 200S 
(IM 151-3 PN) 

As described in guide /3/, assemble the following modules in the 
following order: 

1. IM151-3 PN interface module 
2. Terminal module for power modules  
3. 2 x terminal modules for electronic modules  
4. Terminating module 

Insert the following modules into the now available terminal modules 
in the same order: 

1. PM-E 24 V DC  
2. DI 24 V DC ST 
3. DO 24 V/0.5 A ST 

4.  ET 200S 
(IM 151-1) 

As described in guide /3/, assemble the following modules in the 
following order: 

1. IM151-1 interface module 
2. Terminal module for power modules  
3. Terminal module for electronic modules  
4. Terminating module 

Insert the following modules into the now available terminal modules 
in the same order: 

1. PM-E 24 V DC  
2. DO 24 V/0.5 A ST 

5.  35 mm standard 
mounting rail 

Mount the following devices on the 35 mm standard mounting rail: 

 SCALANCE X208 

 ET 200S (IM 151-3 PN) 

 ET 200S (IM 151-1) 
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Figure 3-5 
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Table 3-5 

No. Focus Action 

1.  Power cables As described in guides /4/, /5/, /6/, prepare the power cables for the 
following devices. 

 ET 200eco PN 

 ET 200pro IWLAN 

 SCALANCE W 788-1RR 

2.  Ethernet & PROFIBUS 
cables  

Prepare the Ethernet and PROFIBUS cables as described in 
the guide. 

3.  Industrial Ethernet  
cabling 
 

Cable the system as follows: 
Connect the devices to the SCALANCE X208 Ethernet switch as 
shown in figure 3-5. 

4.  PROFIBUS cabling 
 

Connect the ET 200S IM 151-1 to the IE/PB LINK PN IO via 
PROFIBUS. 
 

5.  Electrical connections 
 

 Connect the output signals to the inputs of the ET 200S. 

 Connect several output signals to the inputs of the electronic 
block of the ET 200S COMPACT. 

 Supply all necessary voltage points with 24 V voltage from the 
PS. 

 

Note The installation guidelines for Industrial Ethernet networks, ET200 and  
S7-300 must always be observed. 
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3.2 Installing the software 

The table below contains the necessary standard software packages and the 
advisable or necessary extensions for STEP7. 

Table 3-6 

No. Standard software Comment / link 

1.  STEP 7 V 5.4 + SP 5 To configure the S7-300 station and program the user 
program. 

2.  HW update / HSP Install the most current HW updates online or via the HSP 
on the Internet. See \1\. 

3.  GSD XML files Install the current GSD / XML files as described in manual 
/7/: 
 
ET 200S if required, see \2\. 
SCALANCE (necessary for this document) , see \3\. 
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Configuration of a PROFINET IO 
System 4
This chapter describes the configuration of the complete PROFINET IO system. 
For this purpose, a new project is created, the hardware of an S7-300 (PN IO 
controller) is configured and the PN IO devices are connected to PROFINET.  

 

Table 4-7 

Device Chapter Comment 

S7-300 4.3  

SCALANCE X208 4.4  

ET 200S 4.5  

ET 200eco PN 4.6  

IE/PB Link PN IO  4.7  

ET 200S PROFIBUS 4.8 The ET 200S PB is connected to PROFINET 
IO via the IE/PB Link PN IO. 

ET 200pro IWLAN / 
SCALANCE W 

4.9 The ET 200pro IWLAN is connected to 
PROFINET IO via the SCALANCE W IWLAN 
Access Point. 

IWLAN configuration 4.12 This chapter describes the configuration for 
the wireless connection of the IWLAN devices. 
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4.1 Setting the PG/PC interface 

The following section describes the basic settings of the PG/PC interface. The  
“Set PG/PC Interface” dialog box can be accessed within STEP7 and via the menu 
tree. 

 

Table 4-8 

No. Action Comment 

1.  Open the SIMATIC Manager by 
selecting Start-> SIMATIC-> 
SIMATIC Manager. 

 

2.  Open the window with the 
PG/PC-interface settings by 
selecting Options -> Set 
PG/PC Interface  

Select the network card you are 
using. 
Confirm the setting with OK. 
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4.2 Creating a new project 

This section describes the creation of a new project within STEP7.  

 

Table 4-9 

No. Action Comment 

3.  In the SIMATIC Manager, create 
a new project by selecting  
File -> New. 

 

 

4.  Enter a name for the project and 
confirm it by clicking on OK. 
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No. Action Comment 

5.  Insert a new station by selecting 
Insert -> Station -> 
SIMATIC 300 Station. 

 

 

6.  Inserting the S7-300 station has 
now been completed. 
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4.3 Hardware configuration of an S7-300 station 

The following step sequence describes the procedure for configuring an S7-300 
station with a CPU 319-3 PN/DP for a PROFINET IO connection. 

Table 4-10 

No. Action Comment 

1.  Open HW Config by double-
clicking on the SIMATIC 300 
station and then on Hardware. 

 

2.  You can use the hardware 
catalog to insert your hardware 
components.  
If no catalog is displayed, 
activate it using the  
View -> Catalog menu 
command. 

 

3.  In the hardware catalog, first 
navigate via SIMATIC 300 -> 
RACK-300-> Rail. Now use 
drag & drop to move the 
mounting rail to the top left part 
of the HW Config window. 
Subsequently, go to PS-300 and 
insert the power supply you are 
using into slot 1 of the mounting 
rail.  
 
Note: Inserting the power supply 
into the hardware configuration 
is optional. 
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No. Action Comment 

4.  Now navigate to CPU-300 and 
to CPU 319-3 PN/DP. Use 
drag & drop to move the module 
with version 2.8 (V 2.8) to slot 
2. 
 
Note: Please make sure that the 
order numbers of the modules 
match! 

 

5.  The window with the Ethernet 
properties of the CPU opens. 
Enter the desired IP address and 
click on New to create a new 
Industrial Ethernet subnet. Use 
the suggested entries and 
confirm all windows with OK. 
 

 

6.  The CPU has been inserted into 
the S7 controller with PROFINET 
IO network. 
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4.4 Integrating the SCALANCE X208 into the PROFINET IO 
system 

An advantage of the PROFINET architecture is that PROFINET-capable 

network infrastructures, such as the SCALANCE X200 switches, can be 

integrated into PROFINET IO diagnostics. 

In the following table, a SCALANCE X208 is inserted as a PROFINET IO 

device. This function is optional. 

Table 4-11 

No. Action Comment 

1.  In the hardware catalog, 
navigate to  
PROFINET IO -> Network 
Components -> SCALANCE 
X-200 -> SCALANCE X208  

Select order number and version 
of your switch. 
 

 

2.  Use drag & drop to move it to the 
PROFINET network. 
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No. Action Comment 

3.  Double-click on the module to 
open the Properties dialog box of 
the module. In this dialog box, 
you can enter 

 the device name, 

 the GSD XML file to be 
used and 

 the IP address to be 
assigned.  

 

 

4.  To change the device name, 
enter the new name in  
Device Name.  

 

5.  Use the Change Release 
Number… button to select the 
GSD XML file to be used by the 
system. It is recommended that 
the most current version be 
used. Close the window with OK. 

 

6.  Use the  
Ethernet…  
button to enter the IP address of 
the SCALANCE X208. The 
system specifies a free IP 
address in the STEP7 project, it 
can be adjusted as desired. The 
address is dynamically assigned 
during startup of the controller. 
Close the dialog boxes with OK. 
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4.5 Hardware configuration of an ET 200S 

Like PROFIBUS DP slaves, PROFINET IO devices are assigned to the network 
and thus to the controller in the hardware configuration. 

This section describes the configuration of an ET 200S PN within a PROFINET IO 
network. 

Table 4-12 

No. Action Comment 

1.  From the hardware catalog, 
select the IM151-3 PN module 
with the order number from the 
catalog via 
PROFINET IO -> I/O ->  
ET 200S. 

 

2.  Use drag & drop to insert this 
head module into the PROFINET 
line. 
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No. Action Comment 

3.  Click on your IM and from the 
submenu in the tree insert the 
ET 200S modules you are using 
into the respective slots. See 
also chapter 1.3 of this 
document. 

 

4.  Double-click on the IM 151-3 
station to open the Properties 
window of the head module. 
In this window, you can adjust 
the IP address or the device 
name. The device name 
IM151-3PNHF  
is used here. 

Confirm with OK. 

 

 

 !  
Attention 

Each device name, both the controller and the device, must be unique 
network-wide! Two devices must not use the same device name. 
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4.6 Connecting the ET 200eco PN to PROFINET IO 

The procedure for connecting the ET 200eco PN to PROFINET IO is the same as 
for the ET 200S PN station.  

Table 4-13 

No. Action Comment 

1.  From the hardware catalog in  
PROFINET IO -> I/O ->  
ET 200eco PN, select the 
module with the order number. 

 

2.  Use drag & drop to insert this 
module into the PROFINET line. 
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No. Action Comment 

3.  Double-click on the module to 
open the Properties window. 
In this window, you can adjust 
the IP address or the  
Device name.  

The device name 
ET200ecoPN-DO 
is used here. 
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4.7 Connecting the IE/PB Link PN IO to PROFINET IO 

The connection of existing PROFIBUS components, here PROFIBUS DP slaves, to 
a PROFINET network requires links with proxy functionality. The IE/PB Link PN IO 
is such a link. The following steps are necessary to connect the link to the 
PROFINET IO system. 

Table 4-14 

No. Action Comment 

1.  In the hardware catalog, 
navigate to  
PROFINET IO -> Gateway -
> IE/PB Link PN IO -> 
6GK1 411-5AB00 

Select version 2.1 (V 2.1) and 
use drag & drop to move it to the 
PROFINET network. 

 

2.  The Properties window of the 
PROFIBUS interface opens. 
Select a PROFIBUS address for 
the link.  

 

3.  Use the New button to create a 
new PROFIBUS subnet 
according to your desired 
parameters.  
By default, a transmission rate of 
1.5 Mbps and the DP bus profile 
are used. 
Close all windows with OK. 
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No. Action Comment 

4.  The IE/PB Link PN IO is 
displayed on PROFINET. In 
addition, a PROFIBUS network 
has been created. 

 

5.  By double-clicking on the 
module, you can set the device 
name and the IP address. 
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4.8 Connecting the ET 200S to the PROFIBUS DP network 

The available IE/PB Link PN IO allows to connect PROFIBUS I/O to a PROFINET 
network. To show this process, an ET 200S will be connected to a PROFIBUS line 
of the IE/PB Link PN IO in the following steps. 

Note Please observe the address setting on the respective DP slave. The configured 
address must match the address on the DIP switch of the module.  

 

Table 4-15 

No. Action Comment 

6.  In the hardware catalog, 
navigate to  
PROFIBUS DP -> ET 200S  
-> IM 151-1 Standard 

Select the head module (ensure 
that the order number is correct) 
and use drag & drop to move it 
to the PROFIBUS DP Master 
network. 

 

7.  After inserting the module into 
PROFIBUS, the Properties 
window of the IM 151-1 Standard 
opens and the PROFIBUS 
address can be selected. The 
system automatically suggests a 
free address. 
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No. Action Comment 

8.  After exiting the dialog box with 
OK, the DP slave is displayed in 
the configuration. Further 
modules can be added to the 
slave, please refer to the 
hardware catalog for the 
selection of possible modules. 
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4.9 Connecting IWLAN components to PROFINET IO 

A WLAN access point is necessary to connect the ET 200pro IWLAN to 
PROFINET.  

Table 4-16 

No. Action Comment 

1.  In the hardware catalog, 
navigate to  
PROFINET IO -> Network 
Components -> SCALANCE W  

Select your access point and use 
drag & drop to move it to the 
PROFINET network. 

 

2.  In the hardware catalog, 
navigate to  
PROFINET IO -> I/O -> ET 
200pro -> IM154-6 PN HF 
IWLAN 

Use drag & drop to move the 
head module to the PROFINET 
network. 
 
Use drag & drop to move your 
power and I/O modules to the 
hardware configuration of the  
ET 200pro IWLAN. 
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No. Action Comment 

3.  The hardware configuration of 
the PROFINET IO system is now 
complete.  
 

 



Configuration of a PROFINET IO System 

4.10 Creating the user program 
 

36 
PROFINET_IO_Config 

V2.0, ID Number: 22981197 
 

C
o

p
yr

ig
h

t 


 S
ie

m
e

n
s 

A
G

 2
0

1
0 

A
ll 

rig
h

ts
 r

e
se

rv
e

d
 

4.10 Creating the user program  

The following user program exemplifies the easy access to the configured I/O 
modules in bit, byte, word and double word format. 

The blocks are additionally used for module failure diagnostics by PROFINET IO 
controller/devices and PROFIBUS DP master/slaves. 

Table 4-17 

No. Action Comment 

1.  After saving and compiling in HW Config, it can be closed. In the tree of the SIMATIC Manager, 
go to:  
SIMATIC 300(1) -> CPU 319-3 PN/DP -> S7-Program(1) -> Blocks  

2.  In the right window pane, in which previously only the System Data folder and OB 1 have been 
listed, create the following blocks by selecting  
Insert-> s7-Block-> Organization Block: 

 OB 35     (watchdog interrupt OB 100 ms)  
For the execution of the user program in a time sequence that can be better monitored. 

 OB 82     (diagnostic interrupt OB) 
Block for the evaluation of diagnostic interrupts of interrupt-capable modules, here of 
the PN IO controller. 

 OB 83     (insert/remove OB)  
     Block for the diagnostics / evaluation of module failures. 

 OB 86     (rack failure OB) 
Block for the diagnostics / evaluation of failures of expansion units, DP masters, PN IO 
controllers or of DP slaves or PN IO devices. 

3.  Double-click on the OB 35 block 
to open it and insert the code 
shown in the figure. 
 
(By right-clicking, you can insert 
a new network.) 
 
With these code lines the 
outputs of the ET 200 distributed 
I/O are incremented in the 100 
ms grid. 
 
Save the block in the block editor 
and close this editor. 
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4.11 Assigning the device names 

For a classic configuration of a PROFINET IO system, the device names are 
assigned as described in this chapter. The classical way is shown using the 
example of a SCALANCE X. 

Table 4-18 

No. Action Comment 

1.  Connect your programming unit 
to one of the free ports of the 
SCALANCE X 208 to assign 
names to the devices online. 
Switch on the power supply and 
your hardware configuration. 
 
Return to HW Config. 
Select the device to which you 
want to assign a name. For 
example, SCALANCE X208. 
 
Then open: 
PLC-> Ethernet-> Assign 
Device Name 

  

2.  After searching, the SIMATIC 
devices on the PROFINET 
network are displayed.  
Select the SCALANCE X 200, 
use the Assign Name function 
to assign the desired device 
name to the switch.  
 
Close the window with Close. 

 

3.  You can now verify the device 
name by selecting PLC-> 
Ethernet-> Verify Device 
Name. 
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No. Action Comment 

4.  Repeat steps 2-3 for the 
remaining PROFINET IO 
devices. 

 

 

Note To check the selection of the used device, the Flashing on function shown in 
the screen shot of step 2 can also be used. 

 

  

Note There is also the option to automatically commission the PROFINET IO devices. 
See chapter 5.2. 
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4.12 Configuring the IWLAN devices 

After the configuration of the PROFINET IO devices has been completed and after 
the device names have been assigned, the IWLAN parameters of the access point 
and the ET200 pro IWLAN must be set. 

4.12.1 Configuring the IWLAN access point 

Table 4-19 

No. Action Comment 

1.  Exit HW Config and open the 
window with the Ethernet 
properties by selecting PLC -> 
Edit Ethernet Node... 

 

2.  Click on Browse. 
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No. Action Comment 

3.  Select the SCALANCE W and 
confirm with OK. 

 

4.  Enter the desired IP address. 
(192.169.0.105) 
Confirm by selecting “Assign IP 
Configuration” and confirm the 
following dialog box with OK. 
Close the window. 

 



Configuration of a PROFINET IO System

4.12 Configuring the IWLAN devices
 

PROFINET_IO_Config 
V2.0, ID Number: 22981197 41
 

C
o

p
yr

ig
h

t 


 S
ie

m
e

n
s 

A
G

 2
0

1
0 

A
ll 

rig
h

ts
 r

e
se

rv
e

d
 

No. Action Comment 

5.  Now set the IP address of your 
PG/PC so that it is in the same 
subnet as the IP addresses of 
the PROFINET devices. 
 
To do this, open the Internet 
Protocol (TCP/IP) Properties 
by selecting 
Start -> Settings -> 
Network Connection -
>Local Connections 

Click on “Properties” and in “This 
connection uses the following 
items:” double-click on  
“Internet Protocol (TCP/IP)”. 
Select the   
Use following IP-address 
option button and fill out the box 
as shown in the screen shot. 
Close the dialog boxes with “OK” 
and “Close”. 

 

6.  Open your Web browser.  
Enter the IP address of the 
access point. 
Enter the admin password and 
click on Log on. 

 

7.  Start the Basic Wizard in the left 
column in Wizards -> Basic. 
Enter a system name and 
confirm with Next>>. 
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No. Action Comment 

8.  In Country code, select your 
country and confirm with 
Next>>. 
 

 

9.  In SSID, enter a network name 
and select the used wireless 
mode.  
Confirm the entry with Next>>. 

 

10.  The last step summarizes the 
settings. Click on Finish to 
ensure that the Basic Wizard 
settings become effective. 
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4.12.2 Configuring the ET 200pro IWLAN 

Table 4-20 

No. Action Comment 

1.  Use an Ethernet cable to 
connect the ET200pro IWLAN to 
the SCALANCE X.  
 
Assign an IP address, 
(192.168.0.106) similarly to the 
IWLAN access point, to the  
ET 200 pro IWLAN using the 
Simatic Manger by selecting   
PLC -> Edit Ethernet 
Node... 

 

2.  Open your Web browser.  
Enter the IP address of the  
ET 200pro IWLAN. 
Enter the admin password and 
click on Log on. 

 

3.  In the menu tree, restart the 
Basic Wizard. In Country code, 
select your country and confirm 
with Next>>. 
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No. Action Comment 

4.  Enter the same network name as 
in SSID and the same wireless 
mode as for the access point. 
Confirm the entry with Next>>. 

 

5.  The last step summarizes the 
settings. Click on Finish to 
ensure that the Basic Wizard 
settings become effective. Log 
off and close the browser. 
The ET200pro has now been 
connected to the SCALANCE 
W788-1RR via IWLAN. 

 

 

Note You can use the SINEMA E software to plan and start up your WLAN. For more 
information, please refer to \7\. 
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4.13 Downloading the project 

Table 4-21 

No. Action Comment 

1.  In the left project tree of the 
Simatic Manager, select the 
SIMATIC300(1) station and in 
the menu, select  
PLC -> Download. 

 

After downloading the configuration, the CPU automatically assigns the configured 
IP addresses to the IO devices. If the subnet is set up correctly and if the 
configuration corresponds to the actual IO device configuration, the IO devices are 
ready for cyclic data exchange. 

After downloading the hardware configuration, the BF LED of the CPU starts to 
flash. The BF LED of the CPU and the still flashing BF LEDs of the IO devices go 
out when the CPU has correctly established the communication with the IO 
devices.  

This step completes the planning of the configuration. 
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Advanced Configuration & 
Functions 5

5.1 Creating the topology 

5.1.1 Features 

The SIMATIC Topology Editor (STEP 7 V5.4 SP4 and higher) allows topological 
configuration of PROFINET IO systems. 

The topology is configured by interconnecting the interfaces and ports. 

The Topology Editor has the following functions and properties: 

 

 Display of all PROFINET devices and their ports in the project 

 Configured cable length and cable type with calculated signal transit time for 
each port 

 Interconnection data with location code of the individual PROFINET devices 

 Diagnostic information of PROFINET devices for each single port 

 Easy error detection through online/offline comparison of the node data 

 Call of diagnostics (module information) from the Graphic view 

 Import of the network topology 

 

Note For a list with the devices supporting this function, please refer to \4\. 

 

 

With the aid of the Topology Editor, a target topology can be configured, which can 
then be downloaded to the controller. 

The topology can be configured in three different ways: 

 In the Table view of the Topology Editor 

 In the Graphic view of the Topology Editor 

 In HW Config 

 

5.1.2 Instructions 

In this example, the topology is created in the Graphic view of the Topology Editor 
as described in the following table.  

 

Note For a detailed description of creating the topology, please refer to \6\. 
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Table 5-22 

No. Action Comment 

1.  In PN-IO, use the right mouse 
button to select the PROFINET 
IO Topology option. The 
Topology Editor opens. 

 

2.  Go to Graphic view. The IO 
controller and the IO devices are 
displayed. 

 

3.  Click on the port of the controller 
and move a line to the 
SCALANCE X208 port 5. 
Confirm the dialog box with OK. 
The port connection between the 
controller and the SCALANCE 
Ethernet switch has been 
configured. 
Repeat the process for all 
connections. 
 
Exit everything with OK. 

 

 

Note The hardware in the real configuration must be connected as configured in the 
topology. 
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5.2 Automatic commissioning of a PROFINET IO system 

5.2.1 Features 

The “Automatic commissioning of a PROFINET IO system” function is based on 
LLDP. 

Using this function, the IP addresses and device names of the PROFINET IO 
devices are automatically assigned by the respective PROFINET IO controller 
without requiring 

 a removable storage medium (e.g., Micro Memory Card) with stored device 
name or  

 a programming unit (PU).  

 

This minimizes the time and causes of errors when commissioning. The function is 
particularly important when commissioning series machines with identical 
configuration and target topology. 

 

Note For a list of devices supporting this function, please refer to \5\. 

 

 

5.2.2 Instructions 

If your components are new, continue with step 2.  

If you have already configured the PROFINET IO devices for other projects, reset 
them to factory settings as described in step 1: 
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Table 5-23 

No. Action Comment 

1.  Go to the Simatic Manager. 
Reset all IO devices to factory 
settings that are to be 
automatically commissioned.  
To do this, open the Ethernet 
properties of the device by 
selecting 
PLC -> Edit Ethernet 
Node...  

Once the device is online, select 
Reset. 
 
Note:  
If your device has an MMC, 
please delete the card first and 
then reinsert it into the device. 
 

2.  In HW Config on the PROFINET 
IO controller (CPU 319-3 
PN/DP), double-click on PN-IO 
to open the PN-IO properties. 

 

3.  Ensure that the Support 
device replacement 
without exchangeable 
medium option has been 
checked.  
Enter your desired device name.  
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No. Action Comment 

4.  If not already done, create the 
topology as shown in chapter 5.1 
and download the controller. 

 

 

Note For a detailed description of the “Automatic commissioning of a PROFINET IO 
system” function, please refer to \6\. 
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5.3 Start-Up functions 

Fast start-up times of IO devices are essential, for example, for the tool changer in 
the body shop. To reduce start-up times, two configurable functions are available: 

 Prioritized Start-Up 

 Fast Start-Up  

We will show these functions using the configuration of the ET 200eco PN as an 
example. 

5.3.1 Prioritized Start-Up 

The start-up times for Prioritized Start-Up are reduced to 2 seconds. 

Before you configure and test these functions, you can switch off an IO device, for 
instance the ET200eco PN, switch it back on and measure the start-up time. Then 
configure the “Prioritized Start-Up” function as described in the table below. 

Table 5-24 

No. Action Comment 

1.  Select the ET 200eco PN and 
double-click on X1 PN-IO. The 
window with the properties of the 
PN IO X1 interface opens. 

 

2.  Check Prioritized startup. 
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No. Action Comment 

3.  Generate the blocks for “Report 
System Error” as described in 
steps 5 through 7 of table 5-28. 

 

4.  Save and compile the project in 
HW Config. 

 

5.  Download the CPU using the 
SIMATIC Manager. 

 

6.  To test the function, switch the 
ET 200eco PN off and back on. 
It takes only 2 seconds for the 
ET 200ecoPN to start up.  

 

5.3.2 Fast Start-Up 

The start-up time can be further reduced to 0.5-1 sec. when disabling the 
Autonegotiation function. The start-up time is then referred to as Fast Start-Up. 

Note The configuration of the Fast Start-Up function is port-specific. For this reason, 
the configured port must also be used in the real configuration. 

 

 

Table 5-25 

No. Action Comment 

1.  Double-click on the port of the 
ET 200eco PN connected to PN 
IO. In this case, this is port X1 
P1. 
Go to the Options tab. 
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No. Action Comment 

2.  Select the Transmission 
medium as shown in the 
opposite figure and disable 
autonegotiation by checking 
Disable autonegotiation and 
close with OK. 

 

3.  Autonegetiation must also be 
disabled for the SCALANCE X 
208 port 2, where the ET 200eco 
PN is connected.  
Double-click on port 2 of the 
SCALANCE X208. 

 

4.  Select the Transmission 
medium as shown in the 
opposite figure and disable 
autonegotiation by checking 
Disable autonegotiation. 
 

 

5.  Generate the blocks for “Report 
System Error” as described in 
steps 5 through 7 of table 5-28. 
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No. Action Comment 

6.  Save and compile the project in 
HW Config. 

 

7.  Download the blocks to the CPU 
using the SIMATIC Manager. 

 

8.  To test the function, switch the 
ET 200eco PN off and back on. 
It takes only 0.5-1 sec. until the 
ET 200eco PN reconnects to 
PROFINET.  
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Diagnostics of PROFINET IO 
Systems 6
This chapter shows you the diagnostic capabilities enabling you to detect module 
errors in a PROFINET IO system: 

 User scenario 1: Module failure 

 User scenario 2: Cable breakage 

These failure scenarios are simulated and detected using the following diagnostic 
functions. 

Table 6-26 

Diagnostics Chapter Comment 

STEP 7  
basic diagnostics 

6.1  

Diagnostics with the 
Topology Editor 

6.2 The topology must already have been created 
as shown in chapter 5.1. 

Diagnostics using the 
Web server of the 
PROFINET IO 
controller  

6.3 Please make sure that your PROFINET IO 
controller supports the Web server function. 

 

6.1 Diagnostics with STEP 7 Basis 

6.1.1 Enabling the diagnostic function in STEP 7 Basis 

This chapter shows you the basic diagnostic capabilities in STEP7. 

 

Note To diagnose the individual modules via the LED displays, please use the 
relevant operating instructions of the device. 

The system description must be observed for diagnostics via the user program. 

 

 

Table 6-27 

No. Action Comment 

1.  Open HW Config and select the 
online view of the configuration 
via 
Station > Open ONLINE. 
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No. Action Comment 

2.  This overview diagnostics shows 
all parameterized nodes.  
All intelligent modules are 
displayed with status 
information. 

 

6.1.2 Diagnostics of a module failure 

Table 6-28 

No. Action Comment 

1.  The first fault scenario is to 
provoke a failure of an I/O 
module.  

 Remove an I/O module from 
the IM 151-3 PN, e.g. the 
DO module.  

 Press the F5 key to update 
the display. 

This display appears in the 
overview. 

 

2.  Double-click on Device to start 
the detailed diagnostics of the 
device.  
Detailed diagnostics indicate that 
an error has occurred, the exact 
information on the error is 
provided in IO Device 
Diagnostics.  
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No. Action Comment 

3.  After selecting IO Device 
Diagnostics, the error message 
can be read in plain text in 
Standard Diagnostics in the 
center of the window. In this 
case, the failure or the removal 
of the module was diagnosed in 
slot 3. 
As soon as you reinsert this 
module, the error message 
disappears after the update. 

 

 

6.1.3 Diagnostics of a cable breakage 

Table 6-29 

No. Action Comment 

1.  The second fault scenario is to 
provoke a cable breakage. 
Remove the RJ45 plug 
connected via the IE/PB Link PN 
IO from the switch. After the 
update, an error is displayed in 
the following components: CPU 
319-3PN/DP, IE/PB Link PN IO 
and ET 200S PROFIBUS.  

2.  Double-click on the CPU to open 
the CPU Module Information.  
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No. Action Comment 

3.  Go to the Diagnostics Buffer 
tab. This tab displays the  
Station Failure message.  
The Details section shows the 
number of the failed station. 
 
To eliminate the error, plug the 
RJ45 back in and update it. 
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6.2 Diagnostics with the Topology Editor 

After the topology has been created, the option to diagnose the PROFINET IO 
system using the Topology Editor is available in addition to the basic STEP7 
diagnostic functions. 

6.2.1 Diagnostics of a module failure 

Table 6-30 

No. Action Comment 

1.  The Online function in the 
Topology Editor Graphic view 
allows to see the status of the 
PROFINET IO devices. 

 

2.  Provoke the failure of an I/O 
module. 
Remove the DO module from the 
IM 151-3 PN. 
The IO controller and the  
ET 200S whose DO has been 
removed are displayed with a 
red frame. (See figure) 
In the CPU, the BF 3 LED 
flashes and the SF LED is on. 
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No. Action Comment 

3.  Go to the Table view tab and 
click on Online. 

 

4.  The Table view displays the 
failed device with the “\” symbol 
in red. 
The controller and the ET 200S 
whose DO module has been 
removed are displayed with a 
white cross in the red circle.  
 
Reinsert the module. 
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6.2.2 Diagnostics of a cable breakage 

Table 6-31 

No. Action Comment 

1.  Provoke the failure of the  
ET 200eco PN by removing the 
Ethernet cable. 
 
Activate the Online function of 
the Graphic view. 
The device that is not connected 
(or that is defective) is displayed 
with a red cross (see figure).  
In the CPU, the BF 3 LED 
flashes and the SF LED is on. 

 

2.  Go to the Table view tab and 
click on Online. 
 
The Table view displays the 
failed device with the “\” symbol 
in red. 
The controller and the switch to 
which the ET 200eco PN was 
connected are displayed with a 
white cross in the red circle. 
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6.3 Diagnostics using the Web server of the PROFINET IO 
controller 

The CPU Web server offers advanced diagnostic capabilities. Status information 
and status messages are displayed on HTML pages. This enables the user to 
perform evaluations and diagnostics also through the Internet or the corporate 
network.  

6.3.1 Enabling the Web server and generating RSE  

Table 6-32 

No. Action Comment 

1.  The language to be used for the 
messages in the Web server is 
set in this step. 
 
Close HW Config and in the 
SIMATIC Manager open: 
Options-> Language for 
Display Devices  

 

 

2.  In the opening window, select 
your language and apply it by 
clicking on the “” icon. 
 
 

 

3.  Confirm the setting with OK. 

 



Diagnostics of PROFINET IO Systems

6.3 Diagnostics using the Web server of the PROFINET IO controller
 

PROFINET_IO_Config 
V2.0, ID Number: 22981197 63
 

C
o

p
yr

ig
h

t 


 S
ie

m
e

n
s 

A
G

 2
0

1
0 

A
ll 

rig
h

ts
 r

e
se

rv
e

d
 

No. Action Comment 

4.  Open the CPU properties with a 
double-click in HW Config. 
 
Go to the Web tab. 
Enable the Web server for this 
module, the language and the 
automatic update interval for the 
automatic update of the server 
as shown in the screen shot.  
 
Close the window with OK. 

 

5.  Generate the blocks for the 
system error messages by 
selecting Options-> Report 
System Error. 

 

6.  In the opening window, click on 
Generate. 
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No. Action Comment 

7.  Close the following window with 
OK.  

 

8.  Save the project in HW Config 
by compiling. 

 

9.  Download the generated blocks 
to the CPU using the  
SIMATIC Manager. 

 

 

6.3.2 Starting the Web server 

Table 6-33 

No. Action Comment 

1.  Connect your PG/PC to one of 
the available interfaces of the 
SCALANCE X. 
Set the IP address of the PG/PC 
as described in step 5 of table  
4-18. 

 

2.  Open your Web browser.  
Enter the IP address 
(192.168.0.100) of the 
PROFINET IO controller. 
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No. Action Comment 

3.  Set your desired language in the 
top right of the window. 

 

4.  Then click on ENTER >. 

 

5.  In the left menu, go to  
Module Information. 
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6.3.3 Diagnostics of a module failure 

Table 6-34 

No. Action Comment 

1.  Provoke the failure of an I/O 
module. 
Remove an I/O module from the 
IM 151-3 PN, e.g. the second 
DO module.  
Click on 
Ethernet(1):PROFINET-IO-
System(100) to view the 
PROFINET diagnostics.  

2.  The device with the failed DO is 
displayed with an exclamation 
point. 
Click on the module. 

 

3.  The name, the slot and the 
address of the failed DO are 
displayed with a red wrench 
symbol. 

 

4.  When you click on Details, the 
error message with the cause of 
the error is displayed in the 
bottom window. 
 
Error message: PN device 2 on 
PN system 100 Slot 3: Module 
removed.   

5.  Go to the Messages tab.  
This tab displays the error 
message. 
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No. Action Comment 

6.  Go to Topology.  
The device whose DO module 
was removed is marked with a 
red wrench.  
 
 
You can also view the topology 
information via the Table view. 

 

 

Note The IE/PB Link does not support advanced diagnostics; for this reason, the 
graphical representation does not show to which port of the SCALANCE X it is 
connected. The Network topology of device not detectable message is 
displayed at the bottom. 

 

6.3.4 Diagnostics of a cable breakage 

Table 6-35 

No. Action Comment 

1.  Provoke the failure of the  
ET 200eco PN by removing the 
Ethernet cable. 
 
Click on 
Ethernet(1):PROFINET-IO-
System(100) to view the 
PROFINET diagnostics. 

 



Diagnostics of PROFINET IO Systems 

6.3 Diagnostics using the Web server of the PROFINET IO controller 
 

68 
PROFINET_IO_Config 

V2.0, ID Number: 22981197 
 

C
o

p
yr

ig
h

t 


 S
ie

m
e

n
s 

A
G

 2
0

1
0 

A
ll 

rig
h

ts
 r

e
se

rv
e

d
 

No. Action Comment 

2.  The failed device is displayed 
with a red wrench. 

 

3.  Go to the Messages tab.  
The following message is 
displayed: PN device 3 on  
PN-System100:Failure Name 
ET200ecoPN 

 

4.  Go to Topology.  
The failed device is silhouetted 
in red and displayed with a red 
wrench. 
 
You can also view the topology 
information via the Table view. 
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Related literature 7
7.1 References 

This list is not complete and only presents a selection of related references. 

Table 7-36 References 

 Topic Title 

/1/ SCALANCE X Industrial Ethernet Switches SCALANCE X-200  
Operating Instructions 

http://support.automation.siemens.com/WW/view/en/25
508728 

/2/ CPU 319-3 
PN/DP 

S7-300, CPU 31xC and CPU 31x: Installation  
Operating Instructions 

http://support.automation.siemens.com/WW/view/en/13
008499 

/3/ ET 200S SIMATIC Distributed I/O System ET 200S 

http://support.automation.siemens.com/WW/view/en/11
44348 

/4/ ET 200eco PN SIMATIC Distributed I/O ET 200eco PN 

http://support.automation.siemens.com/WW/view/en/29
999018 

/5/ ET 200pro IWLAN SIMATIC ET 200pro Interface Module IM 154-6 PN HF 
IWLAN 

http://support.automation.siemens.com/WW/view/en/33
401769 

/6/ SCALANCE W SCALANCE W-700 Configuration Manual 

http://support.automation.siemens.com/WW/view/en/32
816761 

/7/ PROFINET IO PROFINET System Description 

http://support.automation.siemens.com/WW/view/en/19
292127 

7.2 Internet links 

This list is by no means complete and only provides a selection of useful 
information. 

Table 7-37 Internet links 

 Topic Title 

\1\ Hardware Support 
Package on the 
Internet 

http://support.automation.siemens.com/WW/view/en/22
374877 

\2\ GSD XML for 
ET200S PN on 
the Internet 

http://support.automation.siemens.com/WW/view/en/19
699080 
 

\3\ GSD XML for 
SCALANCE X on 
the Internet 

http://support.automation.siemens.com/WW/view/en/19
999730 

http://support.automation.siemens.com/WW/view/en/25508728�
http://support.automation.siemens.com/WW/view/en/25508728�
http://support.automation.siemens.com/WW/view/en/13008499�
http://support.automation.siemens.com/WW/view/en/13008499�
http://support.automation.siemens.com/WW/view/en/1144348�
http://support.automation.siemens.com/WW/view/en/1144348�
http://support.automation.siemens.com/WW/view/en/29999018�
http://support.automation.siemens.com/WW/view/en/29999018�
http://support.automation.siemens.com/WW/view/en/33401769�
http://support.automation.siemens.com/WW/view/en/33401769�
http://support.automation.siemens.com/WW/view/en/32816761�
http://support.automation.siemens.com/WW/view/en/32816761�
http://support.automation.siemens.com/WW/view/en/19292127�
http://support.automation.siemens.com/WW/view/en/19292127�
http://support.automation.siemens.com/WW/view/en/22374877�
http://support.automation.siemens.com/WW/view/en/22374877�
http://support.automation.siemens.com/WW/view/en/19699080�
http://support.automation.siemens.com/WW/view/en/19699080�
http://support.automation.siemens.com/WW/view/en/19999730�
http://support.automation.siemens.com/WW/view/en/19999730�
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 Topic Title 

\4\ Which PROFINET 
nodes support the 
extended PN 
diagnostics and 
what do you have 
to configure? 

http://support.automation.siemens.com/WW/view/en/23
678970 

\5\ Which PROFINET 
nodes support 
automatic 
commissioning 
and the replace 
device without 
interchangeable 
medium function? 

http://support.automation.siemens.com/WW/view/en/36
752540 
 

\6\ Automatic 
commissioning of 
a PROFINET IO 
system 

http://support.automation.siemens.com/WW/view/en/36
741408 

\7\ Which functions 
does SINEMA E 
provide and how 
do you operate 
SINEMA E to use 
them? 

http://support.automation.siemens.com/WW/view/en/37
864062 
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Table 8-38 History 

Version Date Modification  

V1.0 05/15/06 First edition 

V2.0 01/14/10 Topology configuration, automatic commissioning, Web 
server diagnostic functions and Fast Start-Up in the 
PROFINET IO system added.  

   

 

http://support.automation.siemens.com/WW/view/en/23678970�
http://support.automation.siemens.com/WW/view/en/23678970�
http://support.automation.siemens.com/WW/view/en/36752540�
http://support.automation.siemens.com/WW/view/en/36752540�
http://support.automation.siemens.com/WW/view/en/36741408�
http://support.automation.siemens.com/WW/view/en/36741408�
http://support.automation.siemens.com/WW/view/en/37864062�
http://support.automation.siemens.com/WW/view/en/37864062�
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